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Work smarter and faster! One of Lightroom Classic’s most impac9ul superpowers is its ability to perform 
imports, metadata changes, develop edits, and exports to mulAple photos (hundreds and even 
thousands) at a Ame. In this class we’ll put the pedal to the metal and demonstrate all the batch 
funcAons you can uAlize in your workflow to get more done faster and consistently. 

 

Before You Import: Raw Defaults 

When you import raw photos into Lightroom Classic some se<ngs must be applied to the raw 
data to serve as a star>ng point for your edits. The un-customized se<ngs are called the Adobe 
Defaults, which applies the Adobe Color camera profile, zeros out almost all other se<ngs, and 
applies a baseline configura>on of sharpening and noise reduc>on in the Detail panel. Note, this 
only affects raw photos, so you won’t see any changes to JPG, PSD, PNG, or TIF files (which do 
not have any se<ngs at all applied to them by default). 

There’s nothing wrong with the Adobe Default se<ngs, and there is nothing wrong with keeping 
them as-is. However, if you find that you always end up applying the same se<ngs to all new 
raw photos (like lens correc>on or a specific camera profile or different sharpening se<ngs), 
then you might benefit from customizing the defaults to include your preferred se<ngs. All this 
does is give you a new, and customized, star>ng point for your raw photos. 

Where is the Raw Default Set? 

It is found under Lightroom Classic > Preferences > Presets (PC: Edit > Preferences > Presets). 
Here you will find a panel called Raw Defaults.  

 

Within the Raw Defaults panel you have three basic op>ons for the Master control: 
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Adobe Default: The same Adobe defaults as we’ve had in the past. Adobe Color is the default 
profile, and most se<ngs are zeroed out (with the excep>on of the sliders in the Detail panel). 

Camera Se8ngs: The same as Adobe Default except that a profile will be selected to match your 
in-camera picture style selec>on (instead of Adobe Color). So, if you set your camera to shoot in 
B&W (monochrome), choosing Camera Se<ngs would honor that and you will see that a 
monochrome profile has been applied. Note, unless you shoot with one of the Nikon Z series 
cameras, it just selects a matching profile and does not change any other se<ngs. Nikon Z series 
owners may also see other se<ngs in Basic and Detail panels change based on in-camera 
se<ngs (hopefully we’ll see this extend to other camera makes and models in the future). This 
is an exci>ng new development, and I hope we see this idea of Lightroom Classic doing a be^er 
job of emula>ng the in-camera se<ngs con>nue to evolve. 

Preset: You choose a Develop preset that will be applied by default to all raw photos from all 
cameras (or just specific camera models). This will basically take the place of the old custom 
camera raw default op>on. You can include anything that you are able to include in a preset. 
You can also combine this with the Camera Se<ngs op>on above. 

 

Set the Master Default 

If you only have a single camera or you want all raw photos from all camera models to have the 
same base default se<ngs, then customizing the Master se<ng is the first thing to do. In the 
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old system we needed to create a custom default individually for all cameras even if we wanted 
to apply the same se<ngs, so this is another improvement over the old system. Let’s imagine a 
few scenarios to help make sense of this. 

Scenario One: You don’t want to change anything at all. In this case, leave it set to Adobe 
Default. 

Scenario Two: You want to experiment with le<ng Lightroom Classic change the profile for all 
raw photos based on the in-camera picture style you choose but leave all other se<ngs the 
same as Adobe Default. In this case, choose Camera Se<ngs from the Master drop-down menu. 

Scenario Three: You have a preset that you always apply on import, and you want to make that 
preset the new default for all raw photos, or you want to create a preset for this purpose and 
make that preset the raw default. In this case, you would use the Preset op>on in the Master 
drop-down menu to navigate to and select the desired preset. 

Create a Preset 

Let’s create a preset that simply enables the Auto se<ngs func>on and leaves everything else at 
the Adobe Default but also includes the new Camera Se<ngs func>on for choosing a profile 
based on in-camera picture style. This is just an example, so feel free to include only the se<ngs 
that make sense to your workflow. 

Step One: Select a raw photo and click the Reset bu^on to ensure it is at the Adobe Default 
se<ngs with everything zeroed out. 

Step Two: Go to Develop > New Preset to open the New Develop Preset dialog box. Name this 
preset Camera Se<ngs Auto (or whatever makes sense to you). 

Step Three: Click the Group drop-down menu and create a new group called Raw Default 
Presets (or whatever makes sense to you). 

Step Four: Click the Check None box, and then only check the boxes for Auto Se<ngs and 
Process Version. By not checking the box for Treatment & Profile Lightroom Classic uses the 
previously men>oned Camera Se<ngs func>on for choosing the profile (and if you are shoo>ng 
with a Nikon Z series, possibly some addi>onal se<ngs). Then click Create to complete the 
process. The new preset will appear in the Preset panel within the group you designated. 
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Step Five: Go to the Presets tab of the Preferences, and click the Master drop-down menu, go to 
Preset, and select to the preset you created under the Presets menu (look for the preset group 
you designated). You should then see the name of your preset loaded in the Master drop-down 
menu. 

 

From this point forward, all newly imported raw photos will have the se<ngs included in the 
preset applied to them by default. Likewise, clicking the Reset bu^on in Develop will reset to 
the new default se<ngs. Take some test photos with different in-camera picture styles applied 
and then import them and give your new defaults a test drive. Since hi<ng the Reset bu^on 
applies the Raw Default preset it really isn’t a good idea to include Auto in that preset. 

UpdaDng The Preset 
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Aeer doing some tes>ng you decide that you want to s>ck with the Camera Se<ngs op>on for 
choosing profiles, but you don’t want to have Auto Se<ngs applied AND you want to include a 
lens profile correc>on. Let’s update that preset. 

Step One: With a raw photo selected, click Reset to set to defaults. Then go to the Lens 
Correc>ons panel and check the boxes for Remove Chroma>c Aberra>on and Enable Profile 
Correc>ons. Leave everything else at the default. 

Step Two: Right-click the Camera Se<ngs Auto preset we created earlier (or whatever you 
named it) and choose Update with Current Se<ngs to open the Update Develop Preset dialog 
box. 

Step Three: Only check boxes for Lens Profile Correc>ons, Chroma>c Aberra>on, and Process 
Version. Leave every other box unchecked. Click Update. 

Go ahead and click the Reset bu^on and the selected photo should retain the profile that 
matches the in-camera picture style, the tonal value sliders in the Basic panel should reset from 
Auto, and the boxes in the Lens Correc>ons panel should be checked. To update your default 
se<ngs in the future, just update that preset. Note, be careful not to delete that preset or your 
defaults will revert to the Camera Se<ngs op>on without telling you. 

Make Defaults Specific to Each Camera 

Now that you have a Master se<ng you like, what if you want to have a different default se<ng 
for one or more cameras you shoot with? In that case you’ll want to check the Use defaults 
specific to camera model checkbox under the Master drop-down menu. Once enabled, it brings 
the bo^om sec>on of the new panel to life. 
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Using the Camera drop-down menu you can select the camera model you want to create a 
custom default se<ng for, then use the Default drop-down menu below that to choose from the 
same three op>ons I outlined above, but for that specific camera only. Note, if at first you don’t 
see the desired camera model listed, exit the Preferences and view a folder or collec>on 
containing photos from the desired camera and return to this Preference se<ng. Once 
configured as desired, click the Update Default bu^on to add that configura>on to the panel. 
Note, if you need to set your defaults based on camera body serial number, check the Show 
serial number box and you’ll be able to choose each camera body individually. 



Batch It! Leveraging Batch Func2ons in Lightroom Classic 

 

© Rob Sylvan 7 

 

Once you’ve applied a camera specific default you can modify, update, or delete that se<ng via 
the drop-down menu at the far-right of the panel. Under that menu you will see op>ons for 
choosing Adobe Default, Camera Se<ngs, accessing all your develop presets, or dele>ng that 
camera specific default se<ng. 
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In Closing 

You can of course con>nue to apply a preset during import or when tethering or using Auto 
Import. The Raw Default se<ng you choose is applied first, then any import preset is applied on 
top of the default, and then anything you apply manually aeer import comes next. Think of the 
Raw Default as a >me saving measure to get you to your preferred star>ng point. Think of 
import presets as crea>ve or job specific addi>ons to your default se<ngs to get you to a 
different star>ng point. If all of this seems too overwhelming at first, just leave it at Adobe 
Defaults and do all your edi>ng in Develop manually. There’s no wrong answer, just a few 
op>ons to consider. 

In the old method it was also possible to create a custom default based on ISO se<ngs. That 
op>on has been removed from the interface. However, there is now a new method for crea>ng 
an ISO adap>ve preset. 

One final note, the old shortcut for rese<ng to the Adobe defaults (useful if you had a custom 
default se<ng using the old method) has been discon>nued in this latest update. So pressing 
Command + Shie + R (PC: Ctrl + Shie + R) does the same as just pressing Reset, which is to reset 
the photo based on the se<ngs you’ve chosen in the Raw Defaults sec>on of the preferences. If 
you want a way to get to all zeroed se<ngs and the Adobe Color profile, then you’ll want to 
create a preset that does that and just click the preset when/if needed. 

 

Make the Most of Templates 

One of the main reasons we use Lightroom Classic is that it makes our en>re digital workflow so 
much more efficient than using a combina>on of other tools. A key to ge<ng the most out of 
Lightroom Classic is to gain mastery over all the various types of templates that you can employ 
at different points in your workflow. 

A template (or preset) is essen>ally a glorified text file that allows you to save some set of 
informa>on that you can call into use repeatedly, which is much faster than re-crea>ng or 
entering that informa>on each >me you perform a given task. Note, Lightroom Classic uses the 
words templates and presets somewhat interchangeably, but I try to use the term shown in the 
interface where applicable. 

The types of templates I am talking about appear all over, and some in more than one place. 
Specifically, I am referring to filename templates, metadata templates, and import templates, 
which I like to think of as workflow templates, and all can be accessed from both the import 
screen and the Library module. I want to focus on helping you understand the ins and outs of 
crea>ng and managing these workflow type templates. 

https://helpx.adobe.com/lightroom-classic/help/develop-module-tools.html#iso-adaptive-preset
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Star>ng with the first place in your workflow: the Import dialog. The Import dialog is a mul>-
tasker’s dream, as it’s main purpose is to add photos to the catalog and then front-load the 
en>re process by facilita>ng such jobs as renaming the photos (using a file name template), 
adding core metadata (from a metadata template), applying keywords, and even applying a 
develop preset. You can then save all those se<ngs in an Import preset to reconfigure the 
se<ngs in the future with a click. 

 

Filename Templates 

One of the most commonly used templates are filename templates. There comes a >me in 
every Lightroom user’s workflow when photos need to be renamed, whether during import, 
aeer import, or during export. The filename templates you create can be accessed and u>lized 
no ma^er when you are doing the renaming. On the Import dialog you can find them in the 
aptly named File Renaming panel. Lightroom comes with a few filename templates pre-
installed, and that’s fine, but you can easily create your own with the Filename Template Editor. 
Here’s how: 
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Check the Rename Files checkbox, then click the Template drop-down menu and choose Edit. 
This opens the editor with the tokens used in ac>ve template being displayed. 

Clear the exis>ng tokens from the entry field to start fresh and then create your own template 
using any combina>on of tokens that suit your needs. Note, you can also type text right into 
that field, which is handy for separa>ng tokens with hyphens or underscores. 
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Once you’ve assembled the tokens in the desired format click the Preset drop-down menu and 
choose Save current se<ngs as a new preset, enter a meaningful name, and click Create to 
finish the process. 

You might have different file naming requirements for different jobs, so you can take the >me to 
create as many filename templates as you wish. The least intui>ve part of the process is 
dele>ng unwanted presets, but it is easy once you know how (and it works the same way with 
all other templates we’re going to cover). To delete a filename template, click the Preset drop-
down menu in the Editor and choose the one you want to delete. Then click the Preset drop-
down menu a second >me and choose Delete preset “[preset name]” to remove it for good. 
Note, there is also the op>on to rename the template too. 

 

Metadata Template 

Another template you should be taking advantage of right from the start is the metadata 
template. At the most basic level the metadata template allows you to apply important 
copyright and contact informa>on into the metadata of every photo as part of the import 
process. On the Import dialog, expand the Apply During Import panel and click the Metadata 
drop-down menu to choose New and open the Edit Metadata Presets editor. 
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At a bare minimum I recommend filling out the IPTC Copyright sec>on and as much of the IPTC 
Creator field as you feel comfortable with to assist people with contac>ng you should they find 
one of your images in the wild. I like to fill out the phone (using a Google Voice number), email, 
and website fields. Keep in mind that any field that has a check mark will be included in the 
preset. 

If the checked field is empty, it will simply wipe that field on every incoming photo and leave it 
blank (I have a template I some>mes use to wipe any exis>ng keywords from photos during 
import), so make sure no fields get checked by accident. To save your metadata template just 
click that Preset drop-down menu and choose Save current se<ngs as a new preset. Like the 
filename templates men>oned earlier, you can delete, rename, and update templates the same 
exact way with that drop-down menu. 

Import Preset 

Now most of the se<ngs on the Import dialog are s>cky, meaning that once you’ve had a 
successful import those se<ngs will remain configured the same way the next >me you do an 
import. However, if you are the habit of changing certain se<ngs based on your workflow needs 
you would benefit from preserving your core se<ngs in an Import preset. The Import Preset 
menu can be hard to spot. It is located on the bo^om of the Import dialog in the center of the 
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screen. Once you have configured the Import dialog the way you want it, click the Import Preset 
drop-down menu and choose Save current se<ngs as a new preset (are you detec>ng a pa^ern 
yet?), and give it a meaningful name. Dele>ng these presets involves the same process of 
selec>ng the desired preset from the drop-down menu, then clicking the menu a second >me to 
access the delete op>on. 

 

Keep in mind that once you are through the import process you can always batch rename 
photos by selec>ng the photos while in Grid view of the Library module, and going to Library > 
Rename photos menu. You’ll have access to the same set of filename templates as well as the 
Filename Template editor. Likewise, if you need to go back and batch apply your new metadata 
template to previously imported photos you can also do that from Grid view by selec>ng all 
photos and choosing your metadata preset from the Preset drop-down menu located at the top 
of the Metadata panel. 
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Closer Look at the Metadata Panel 

At first glance you may not no>ce anything different about this panel, but upon closer 
inspec>on the Default view of the panel has changed and gained new op>ons. 

 

At the top lee is a new icon resembling an eye (and a >ny pencil), which represents View and 
Edit mode. This is the default mode for this panel, and it allows you to view all available fields 
and alter any of the editable fields displayed. When clicked, you’ll switch to Edit Only mode, and 
you’ll only see fields displayed that allow associated metadata to be edited. This way if you are 
only interested in edi>ng available metadata switching to Edit Only mode clears away any fields 
that can’t be changed by Lightroom Classic (and improves performance when working with a 
large batch of photos by not displaying other informa>on). 
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Below the Preset drop-down menu are two bu^ons that are only ac>ve when you have more 
than one photo selected. These control what metadata is displayed in the panel when mul>ple 
photos are selected in Grid view. Let’s say I have mul>ple photos selected but only want to view 
and poten>ally edit the metadata for the ac>ve or target photo, then with Target Photo selected 
in the panel, I will only see the info related to the ac>ve (or some>mes called most-selected) 
photo. 
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However, if I want to change the metadata for all selected photos, perhaps they all could have 
the same cap>on, then I could select Selected Photos, and the info I enter in the Cap>on field 
will be applied to all selected photos. When there are fields that contain different informa>on 
for two or more of the selected photos, you’ll see appear in that field to alert you to this 
situa>on. 

 

Note, you may see the Set Metadata on Mul>ple Photos prompt, where you’d need to click 
Apply to Selected to complete the process. 

 

Changing Views 
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In the header of the Metadata panel is a drop-down menu that allows you to switch between 
different ways of viewing available metadata. If you have (or have not) installed certain third-
party plug-ins you may see different op>ons than what are shown here. 
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I recommend clicking through each view to see what fields are displayed. Most of them are self-
explanatory. I’ll point out the Three Dimensional Projec>on view is for displaying or edi>ng this 
specific metadata field, which can be used with 360° panoramas so that they are displayed 
correctly in apps, like Facebook, that can read that field and allow you to pan around within the 
photo (note, there may be other file requirements for correct 360° pano display). 

There are two broad types of metadata you can display, and in some cases edit, in Lightroom 
Classic. There is the technical metadata created by the camera at the >me of capture called EXIF 
(Exchangeable Image File Format), such as exposure informa>on and capture date/>me. Then 
there is the descrip>ve type of metadata that the creator can add to the photo both in camera 
and in soeware, called IPTC (Interna>onal Press Telecommunica>ons Council), such as cap>on, 
>tle, and copyright. The various views within the Metadata panel provide access to different 
combina>ons of these types of data fields. Some are editable within Lightroom Classic, like 
>tles, copyright info, and capture date, but many technical data fields, like ISO, shu^er speed, 
and aperture are not editable at all. 

 

Pain2ng Your Photos with Informa2on 

The oeen-overlooked Painter tool can be a real >me saver when working with large groups of 
photos in Grid view of the Library module. I always find myself forge<ng about the Painter tool, 
then I come up against a project where I need to scroll through hundreds of photos for some 
reason-such as assigning a new keyword, adding them to a collec>on, or applying a flag-and 
then I remember the Painter! Do you see that li^le spray paint icon in the Grid view Toolbar? 

 

If you don’t see it make sure you are in Grid view by pressing G, and if you s>ll don’t see it then 
press T to make sure the Toolbar is visible. What? S>ll don’t see it? OK, click the drop-down 
arrow on the far-right end of the Toolbar and make sure Painter is checked. Got it now? Good. 

https://www.photometadata.org/META-Resources-metadata-types-standards-Exif
https://www.photometadata.org/META-Resources-metadata-types-standards-Exif
https://iptc.org/standards/photo-metadata/
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Aeer selec>ng the Painter from the Toolbar to enable it (or go to Metadata > Enable Pain>ng) 
you can load it with keywords, color label, flag state, star ra>ng, metadata template, develop 
preset, rota>on se<ng, or even a collec>on. Once enabled, the Toolbar will change to reveal 
the Painter’s op>ons, so if you choose Keywords then a keyword entry field will appear, 
choosing Label will display the color label choices, Metadata will provide a list of all your 
metadata templates and so on. This tool can really help speed up an otherwise tedious task and 
even make it a li^le more fun. 

One of the ways I like to use this tool is when I am adding photos to an exis>ng collec>on. The 
first thing I do is ctrl-click (PC: Right-click) the collec>on I want to use, and choose Set as Target 
Collec>on from the contextual menu that appears. You’ll see a li^le + icon appear next to that 
collec>on in the Collec>ons panel, which iden>fies it as the target collec>on. As an aside, by 
default the Quick Collec>on is the target collec>on, so once you assign a new target collec>on 
the keyboard shortcut B will also add photos to the target collec>on. To un-assign the target 
collec>on just ctrl-click (PC: Right-click) the collec>on again and uncheck Set as Target 
Collec>on. With our target collec>on assigned let’s go through the steps to use it with the 
Painter tool. 

One: Enable the Painter tool. 

Two: Click the Painter tool drop-down menu and choose Target Collec>on from the list. 

 



Batch It! Leveraging Batch Func2ons in Lightroom Classic 

 

© Rob Sylvan 20 

Three: Click and drag the Painter tool over the photos you want to add to the target collec>on. 
You’ll no>ce the cursor has changed to the Painter icon when you place it over a photo, and as 
you click and drag the can animates to appear like it is spraying. 

 

If you “overspray” and hit a photo you didn’t want to add to that collec>on you can hold the 
Op>on (PC: Alt) key to change the painter to an eraser and click and drag over those photos to 
remove from the target collec>on. Note, if you are pain>ng with a metadata preset, rota>on, or 
a develop preset you can’t erase the overspray with the Painter tool, but CMD/Ctrl-Z does undo 
if you catch it right away. 

Five: When you have finished with the Painter you can click the Done bu^on in the Toolbar or 
press the escape key to exit the Painter tool. 
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The basic process works the same with whatever item you have loaded in the Painter, but there 
are a couple of things I want to bring to your a^en>on. If you are working with keywords the 
keyword field will access your exis>ng keyword list as you type and display a lis>ng of all the 
keywords that match the le^ers you have entered, which speeds up adding exis>ng keywords. 
To enter mul>ple keywords just type a comma aeer the first keyword and start typing the next 
keyword. You can even access your keyword sets by holding the Shie key, and load keywords 
that way. 

 

 

Exploring Batch Edi2ng Op2ons 

Lately, I’ve been trying to learn about focus stacking as the latest mirrorless cameras all seem to 
have a focus bracke>ng op>on. I’ve s>ll got a lot to learn (which is awesome), but it got me 
thinking about all the many ways Lightroom Classic allows us to increase our post processing 
efficiency through various batch edi>ng func>ons. I couldn’t believe how many op>ons there 
were when I started lis>ng them out. 

Batching the Baseline 

The first place to start is by se<ng your Raw Defaults, so be sure to go through that if you 
haven’t yet. By customizing your Raw Default se<ng you are batch edi>ng right out of the gate. 
The gate, so to speak, is the Import dialog window, and that is where the second op>on for 
batch edi>ng can be found. If you expand the Apply During Import panel you’ll see the Develop 
Se<ngs drop-down menu. 
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Keeping in mind that our Raw Default se<ng is being applied to all raw photos automa>cally 
the Develop Se<ngs drop-down is an opportunity to apply what I consider crea>ve or 
addi>onal edits that might be more job specific in the form of a Develop preset that you’ve 
already made. For example, let’s say that my Raw Defaults se<ng includes a generic profile (like 
Adobe Color) as a star>ng point for all raw photos. But now I am about to import a set of 
landscape photos, so I can take my batch edi>ng to the next level by selec>ng a preset that 
includes the Adobe Landscape profile and my preferred Detail panel se<ngs for landscapes. 

Now, I don’t take advantage of applying a Develop Se<ngs preset to all imports because the 
preset will be applied to all imported photos, and that may not be appropriate for all import 
sessions. Just file that away as an op>on to consider when it makes sense in your workflow. 

Right AKer Import 

Aeer import you’re going to land in the Library module, and aside from the important viewing, 
sor>ng, and management tasks you’ll need to do there are several op>ons for batch edi>ng 
here too. The most powerful set of op>ons can be found in the Quick Develop panel. 
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Once expanded, you’ll also want to click all three of the white disclosure triangles that are found 
within each subsec>on of the panel to reveal all possibili>es. The key to batch edi>ng in the 
Library module is that when you work in Grid view (press G) you can select mul>ple photos and 
then apply se<ngs to them all at once. If you are in Loupe view, then only the most selected, or 
ac>ve, photo is affected by whatever ac>on you take. 

For example, let’s say I opted not to apply a preset during import because the batch of photos I 
imported were a mix of portrait and landscape photos. Here in Grid view, I can select all the 
portrait photos, then click the Saved Preset drop-down menu and choose my preferred Portrait 
preset to have it applied to all selected photos, then select the landscape photos and apply my 
preferred landscape preset. All before even se<ng foot in the Develop module. 
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Another cool thing about the Quick Develop panel is that all the bu^ons within the Tone Control 
sec>on of the panel are rela>ve adjustments. Meaning that if I click the +1/3 stop Exposure 
bu^on all selected photos get nudged +1/3 stop from whatever their current Exposure se<ng is 
currently (instead of se<ng them all to precisely +1/3 stop as it works in the Develop module). 
Think of it this way, say you import a batch of photos and for whatever reason, they all look a 
li^le underexposed. Just select them all and use the Exposure bu^ons in Quick Develop to 
nudge up their brightness a li^le (you can always refine your adjustments later in Develop). This 
can be a useful tool for evalua>ng your photos while trying to decide if they are keepers or not. 
When you are ready, take the keepers to the Develop module where even more batch op>ons 
are wai>ng. 
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As you might expect the Develop module is packed with batch edi>ng opportuni>es to make 
your workflow more efficient. The simplest op>on is the easily overlooked Previous bu^on at 
the bo^om of the right panel group. 

 

One reason it is easily overlooked is that it only appears when only one photo is selected in the 
Filmstrip. All the Previous bu^on does is apply all the se<ngs you applied to the previously 



Batch It! Leveraging Batch Func2ons in Lightroom Classic 

 

© Rob Sylvan 26 

edited photo to the new photo that is now selected. This is most useful when edi>ng a set of 
very similar photos and aeer edi>ng the first, you move to the second and decide it should get 
the same exact treatment. Theore>cally, you could manually edit the first photo, then use just 
your right arrow key and the Previous bu^on to work your way through edi>ng the en>re set. 

That’s not terribly efficient though, so that’s where you might employ the Sync bu^on instead. 
You can start the same way by manually edi>ng the first photo, but then select all similar photos 
in the Filmstrip (but keep your edited photo as the ac>ve photo) and watch the Previous bu^on 
change to Sync. 

 

Then click the Sync bu^on to open the Synchronize Se<ngs dialog box and choose which 
se<ngs you want to be synced from your edited photo to all of the rest. This is not only a whole 
lot faster than using the Previous bu^on through an en>re set, but it also gives you control over 
what se<ngs you want to synchronize. If you intended to sync all se<ngs, click the Check All 
bu^on, then the Synchronize bu^on, and away you go. 
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If you are really in a hurry, and like walking on the wild side, click that li^le switch to the lee of 
the Sync bu^on to change it to Auto Sync. Once Auto Sync is engaged, all edits you make to the 
ac>ve photo are automa>cally synced to all selected photos in real >me. This is a very powerful 
se<ng. You could theore>cally edit an en>re set of photos all at once, which is exactly what I 
did with my photo sets for focus stacking. It is so powerful that Adobe recently made Auto Sync 
more visibly highlighted when it is enabled and even pops up a bezel displaying what edits are 
being auto synced to all selected photos each >me you move a slider, click a bu^on, check a 
box, or apply a preset. As soon as you are done with your Auto Sync session, click that same 
li^le switch to change it back to Sync. 
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Another op>on to consider is Copy and Paste. You can think of this as a version of the Sync 
func>on, but instead of syncing se<ngs to all selected photos it loads your desired se<ngs into 
your clipboard so that you can paste those se<ngs to a photo as needed while working through 
an edi>ng session. Here’s how it works, first, like all the other op>ons so far, you edit a photo. 
Then, if there are se<ngs you’ve applied that you think you will want to apply to other similar 
photos in that set, click the Copy bu^on to open the Copy Se<ngs dialog where you can choose 
the se<ngs you want to have at the ready. 

 

Thinking back to our simple example of a batch photo containing both landscape and portrait 
photos, you could manually edit the first portrait photo, then use the Copy bu^on to copy key 
se<ngs, and then when you encounter the next portrait photo in the set, use the Paste bu^on 
to apply those same se<ngs before fine tuning for that photo. Here’s a handy guide to all of the 
keyboard shortcuts for these op>ons to really add some efficiency to your workflow: 

§ Paste se<ngs from Previous: CMD+Op>on+V (PC: Ctrl+Alt+V) 

§ Sync se<ngs: CMD+Shie+S (PC: Ctrl+Shie+S) 

§ Enable/Disable Auto Sync: CMD+Op>on+Shie+A (PC: Ctrl+Alt+Shie+A) 

§ Copy se<ngs: CMD+Shie+C (PC: Ctrl+Shie+C) 

§ Paste se<ngs: CMD+Shie+V (PC: Ctrl+Shie+V) 

Post Develop Module 

We’ve covered a lot of batch edi>ng op>ons, but I want to leave you with one more, which is 
back in the Library module. While it may be nice to edit an en>re shoot in a single session in a 
nice linear fashion, there are many >mes where that is just not possible for a variety of reasons. 
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I want to point out that there is also a Sync Se<ngs bu^on in the Library module too. It works 
just the same as the Sync bu^on in the Develop module (same shortcut too). Just select the first 
photo with se<ngs, then select the rest of the photos you want to sync those se<ngs across, 
and click the Sync Se<ngs bu^on at the bo^om of the right panel group. That will open the 
now familiar Synchronize Se<ngs dialog where you can choose which se<ngs you want to 
apply to the rest of the selected photos, then click Synchronize to complete the task. 

 

In fact, using the keyboard shortcuts I men>oned previously, you can even invoke the Copy, 
Paste, and Previous func>ons while in the Library module. This combo of features gives us a 
tremendous amount of power to edit our photos faster and more consistently by leveraging the 
work we’ve already done to apply it to other similar photos. I highly encourage you to pick one 
of these many op>ons and start implemen>ng it in your workflow. Once it becomes second 
nature, add another, and before you know it you will have transformed the way you edit and 
reduced the amount of >me it will take.   

 

Batch Cropping 

I’ve oeen been asked if there was a way to set a default crop ra>o, so that every >me you 
brought a photo into the Crop tool it would automa>cally be cropped to that aspect ra>o. 
Unfortunately, there isn’t a way to do that, but here’s the next best thing. 



Batch It! Leveraging Batch Func2ons in Lightroom Classic 

 

© Rob Sylvan 30 

Let’s say we need to crop a batch of photos (however many you want) to 5 x 7 (or any aspect 
ra>o you desire). Start in the Library module by selec>ng the source (folder or collec>on) 
containing all of the photos. Next, press G for grid view, and select all the photos you want to 
crop. 

 

Next, expand the Quick Develop panel. 
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If needed, click the disclosure triangle next to Saved Preset to see the other op>ons hidden 
there. 

 

Now, click the Crop Ra>o drop-down menu and choose the desired aspect ra>o. In my case, I 
chose 5 x 7. 

 

As soon as the new aspect ra>o is clicked, all selected photos are cropped to that ra>o. The 
thumbnails will start to update accordingly. 
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To finesse the crop on each photo, select the first photo in the batch and press the R key to 
jump to the Crop tool. Upon arrival you’ll see that the photo is cropped to the desired aspect 
ra>o and now you can just tweak the crop rectangle for best impact. You can then quickly move 
through the rest of the batch tweaking as needed. That’s a whole lot faster than se<ng the 
aspect ra>o one at a >me. 

 

Catalog Dashboard 

Well, I’ve wri^en a whole post about my catalog dashboard at LKT, but in a nutshell it is a bunch 
of smart collec>ons that I use to track the growth of my catalog and help me stay on top of 
certain aspects over >me. The beauty of it is that it is completely free (no special plug-ins 
required) and completely customizable (within the limits of smart collec>ons) to suit your own 
needs (which may differ from mine). 

All the smart collec>ons are organized using collec>on sets, which are also free and completely 
customizable. I’ve got a post for you if you need a refresher on mastering collec>ons. Lightroom 
Classic (LrC) is built on a database aeer all, so this is simply one way to leverage that database 
for your benefit. So, I’ll show you mine to inspire you to create your own, and make it work for 
you. 

https://lightroomkillertips.com/building-catalog-dashboard/
https://lightroomkillertips.com/mastering-collections-lightroom-classic-part-2/
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In its current form, my dashboard consists of three sec>ons (collec>on sets): 

§ Edits 

§ File Types 

§ Metadata Data (yes, I realize that’s redundant, so name yours as you wish) 

Here’s a look at what smart collec>ons I’ve found helpful or hope to find helpful within each 
sec>on. 

Edits 

Within the Edits group I have smart collec>ons for tracking the following: 

§ Black and White 

§ Has Snapshots 

§ New Photos with no Edits 

§ Recently Edited 

The Black and White smart collec>on, as is true of most of these smart collec>ons, is very 
simple. Most of them have just one or two rules. If I open the smart collec>on for edi>ng I can 
see that it consists of a single rule for Treatment is black and white. I had set that up years ago 
for a project, and while I don’t use it much currently, I find it interes>ng enough to keep around. 
When it comes to “treatment” in this context it uses the profile as the way to determine if it is 
B&W or not. If I take a photo with a color profile (like Adobe Color) and simply move the 
Satura>on slider to -100 that photo will not show in this collec>on. 
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The Has Snapshots is similar in that it is a single rule, Has Snapshots is true, to gather up all 
photos that I have ever created at least one Snapshot for in the course of edi>ng (learn more 
about Snapshots if you are interested). 

New Photos with no Edits reminds me about newly captured photos that I haven’t edited yet, so 
it has 2 rules, with the first being Capture Date is in the last 30 days AND Has edits is false. 

Recently Edited doesn’t care about capture date but instead uses Edit Date is in the last 30 days 
AND Has edits is true. This is because I oeen re-edit old photos just as much as edit new photos 
due to the teaching and wri>ng that I do. I’m always mining my catalog for gems, and re-
polishing old gems with new techniques. 

There’s so much more one could do with smart collec>ons in this area, and I’d love to hear 
other ideas you may have in the comments. 

File Types 

This one does what it says on the >n, as the saying goes. I simply have smart collec>ons for all of 
the different file types (and variants in the case of DNG files) that LrC supports. This helps me 
manage those over >me. 

https://lightroomkillertips.com/using-virtual-copies-snapshots/
https://lightroomkillertips.com/using-virtual-copies-snapshots/
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For example, before LrC had the ability to merge to HDR, I oeen used the 32 bit TIF route for 
crea>ng HDR files. Those files are huge! And now, when I have >me, I go through those and re-
create them with new HDR techniques, and if I like the new version be^er I delete the old. 
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Similarly, I occasionally have short term use for Lossy DNG files, so by tracking them here, I can 
easily find them, mark them as rejects, and ensure they are removed when no longer needed. 
Now that PSB files are supported, I similarly want to keep track of those monster files. 

I include smart previews in this collec>on because they do take up space on my drive even 
though they can be created for all s>ll photo file types. I can then use this smart collec>on 
to manage them over >me. I track raw files (as in proprietary raw formats) vs. DNG because I 
eventually convert all old proprietary raw files to DNG to recover disk space. 

Each of these are simple one rule smart collec>ons like this one for PSD, which is File Type is 
Photoshop Document (PSD). 

 

Metadata Data 

The final group is a variety of smart collec>ons that monitor certain bits of informa>on about 
each photo stored in its metadata. The first >me I men>oned my catalog dashboard was in a >p 
on tracking the Copyright Status field. Over >me I’ve added smart collec>ons for color 
labels, Depth Map, Metadata Conflicts, and Rejected Photos. 

https://lightroomkillertips.com/large-document-format-psb-support-in-lightroom-classic/
https://lightroomkillertips.com/managing-smart-previews-lightroom-classic/
https://lightroomkillertips.com/copyright-status-tip/
https://lightroomkillertips.com/making-the-most-of-color-labels-in-lightroom-classic-part-2/
https://lightroomkillertips.com/making-the-most-of-color-labels-in-lightroom-classic-part-2/
https://lightroomkillertips.com/new-depth-mask-finding-options-in-lightroom-classic/
https://lightroomkillertips.com/useful-metadata-smart-collections/
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Like the others, these are all one or two rule smart collec>ons that dig into some aspect of the 
photo’s metadata and surfaces it in a way that makes it easy for me to keep an eye on or to 
access those photos for some purpose (like ensuring photos flagged as rejected get deleted). 

I know this dashboard is in a constant state of evolu>on, and as new file types become 
supported, or new features are added, I know I’ll keep tweaking and modifying the contents of 
the dashboard to suit my needs. I hope you find it helpful. Here’s to 200 more blog posts in the 
future! 
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Edit Capture Time 

I once traveled to Colorado as part of the training staff for a Best Buy event (they really put 
together a great program for their camera sales staff), and I forgot to change the >me in my 
camera when entering the new >me zone. Not a huge deal for these photos, but also a very 
easy deal to fix in Lightroom Classic. File this away in case it happens to you. 

 

Step One: Select the photos you want to correct in Grid view of Library module. 

Step Two: Go to Metadata > Edit Capture Time to open the Edit Capture Time dialog box. 

Step Three: Choose the desired type of adjustment. 
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Step Four: Make the adjustment and verify the corrected >me is accurate. 

Step Five: Click Change All to make the correc>on. 

 

In my case I used the Shie by set number of hours op>on and dialed in – 2 to correct for the 
>me difference between the east coast and mountain >me. 
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If you had incorrectly set the camera’s date/>me you would select the first op>on, Adjust to a 
specified date and >me, and then enter the correct date/>me for the ac>ve/most selected 
photo that shows in the dialog box. Lightroom will use that informa>on (the difference between 
the capture date/>me in camera and the corrected date/>me you enter) to adjust the 
date/>me by the correct amount for all selected photos.  

 

Adap2ve Presets 

The updates to Masking in the latest round of updates from Adobe have made making AI-based 
selec>ons easier and more powerful than ever. In addi>on, our ability to incorporate those AI-
based technologies into presets has evolved as well. 

 

Exploring Included AdapDve Presets 

You may have no>ced new addi>ons to your Presets panel in the Develop module that start 
with the word Adap>ve. There are four Adap>ve groups now, one for Portrait, one for Sky, one 
for Subject, and one for Blur. The presets in these groups were created by Adobe to give you a 
taste of what is now possible to include in a preset. We’ll use these to understand how they 
work, then I’ll show you how to create and modify your own. 
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Let’s expand the Adap>ve: Subject group and see what’s included. You should see names like 
Pop, Warm Pop, Soe, Cool Soe, and so on. What all the Adap>ve groups of presets have in 
common is that they are designed to leverage one of the AI-based types of Masking tools to 
automa>cally detect either a person, sky, or subject respec>vely, then create a mask for it, and 
then apply the included se<ngs to that mask. So, select an unedited photo that has some kind 
of obvious subject (I’m always curious to see if the AI thinks the subject is the same subject I 
expect), and move your cursor over each preset slowly (as it may need a moment to generate a 
mask on the fly based on the photo’s subject), and you should see the look of the subject 
change based on the se<ngs in the respec>ve preset. 
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When you find a look that you are curious about, click on it to apply it to the photo. Then, click 
the Masking icon to open the Masking tools so you can select the mask it created and examine 
the se<ngs. I clicked on the one called Pop, and I can now see it included se<ngs for Exposure, 
Texture, and Clarity, which were applied to the mask it created for what it considered the 
subject (and in this case, I would agree). 
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Now, you may or may not like the look of any of the included presets, but I highly encourage you 
to click on each one in the Subject group and examine what it masked, how well it masked, and 
what se<ngs it used to get its look. As you explore those presets think about what you would 
do differently, what se<ngs would you change, and what other mask types would you like to 
create. 

Now, select an unedited photo of a person where you can see their eyes and teeth (along with 
the rest of their face). Expand the Adap>ve: Portrait group to see the included presets and click 
the Masking icon to open its panel (there should not be any masks yet). Click the first preset, 
Enhance Portrait to see what masks are applied to your photo. You should see a mask for Teeth, 
Iris and Pupil, Eye Sclera, and Face Skin. Explore each mask’s se<ngs. 
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Now, in turn, click each of the other presets in the Adap>ve: Portrait group to see those masks 
added to, and in some instances replace, the masks created by the first preset. By the end your 
photo may not look great, but that’s not the point. The point is that because of the updates to 
how portrait masks can be generated it is now possible to automate the crea>on of masks (with 
se<ngs) for individual features, such as hair, teeth, face skin, and so on. Furthermore, you can 
create an individual preset for each feature alone and know that you can later apply them all to 
a single photo and they will stack accordingly. This is incredibly powerful when applied to a 
single photo but now think about applying presets to a batch of photos at once, and it just may 
change your workflow! 
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In addi>on, no>ce that at the top of the Presets panel the Amount slider should be enabled for 
all the included Adap>ve presets, which means you can fine tune them aeer they’ve been 
applied for even more control. Let’s say you apply the Smooth Hair preset, then move the 
Amount slider to 78, if you look at the top of the Masking panel, you’ll see the Amount slider 
there corresponds to that same amount. If you apply Enhance Portrait and move the Amount 
slider to 150, then each respec>ve mask created by that preset will see its se<ngs moved to 
150 as well, but without affec>ng any of the other masks created by other presets or manually 
by you. What amazing control! 
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So that’s just the presets provided by Adobe. Hopefully the crea>ve wheels in your mind are 
turning now as you think about all the possibili>es for customizing these to your own personal 
workflow and taste.  

Let’s keep working with that portrait photo you have selected and click the Reset bu^on to clear 
away any exis>ng masks and se<ngs. Click the Masking icon (if not s>ll in Masking mode) and 
look for the People sec>on under Add New Mask (at the bo^om). Click the icon for the person 
shown to see all the individual features that can be detected and masked. Now, you could check 
En>re Person, and have a single mask for the whole person, but for this exercise, uncheck En>re 
Person and instead check each individual feature. Then, at the bo^om, make sure Create 8 
separate masks is checked and click Create Mask. 
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Eight individual masks will be applied to the photo, and at this point, each mask has no se<ngs 
included. Think of it as a blank canvas awai>ng your brush. You can make this a template that 
you can use to quickly make new presets down the road. In the Masks panel, double-click on 
each mask and rename the Mask Group to reflect the feature being masked (instead of Mask 1, 
and so on). When you’re done your masking panel will be a lot easier to read what each mask is 
affec>ng. 
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Let’s save all that work as a preset. Click the + sign at the top of the Presets panel and choose 
Create Preset. In the New Develop Preset dialog box, click the Group drop-down menu, choose 
New Group, and name the new group something like My Adap>ve Presets or whatever makes 
sense to you. Then click the Check None bu^on at the bo^om to clear all checkboxes. Under 
Masking, check the box next to each Mask Group name (this is why I had you rename those 
Mask Groups previously). I’d leave Support Amount Slider checked, but that’s all. Give your 
preset a meaningful name, like Portrait Template, and click Create. 
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That will create a new preset group in the Presets panel and place your new preset within. Now 
you’ve got a powerful preset that does nothing except create masks for each portrait feature. 
Here’s where you get to customize and play with se<ngs. One at a >me, click on each Mask 
Group and adjust the se<ngs for that specific feature to make it look good to your taste. Don’t 
worry about it being perfect for all photos, just tweak and adjust for this one. Once you’ve 
adjusted the se<ngs for each feature, click the + sign above the Presets panel and create a new 
preset. Give it a meaningful name, in my case Enhance Portrait: Teen Male, make sure all the 
Masking boxes are checked (and support Amount slider), and click Create. The preset group you 
created previously should s>ll be selected, but always worth double-checking so you can find it 
again. 
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That preset will be added to your preset group along with your template. Now that you know 
how this works you can use your template preset as a star>ng point for crea>ng new presets for 
different looks, and different portrait subjects. If you want to make presets for single features 
(like just hair), then only check the box for the Hair mask group. You can be as granular as you 
wish. If portraits are not really your thing, then try those same steps but with using a landscape 
photo with an obvious sky for applying the Select Sky masking tool. Or experiment with Select 
Subject and Select Background for automa>ng the crea>on of masks for the subject in your 
photo with different se<ngs for the background. Use the included presets for inspira>on. When 
you are comfortable with applying these presets to individual photos try selec>ng a batch of 
photos in Develop, enable Auto Sync, and apply one preset to all selected photos to really speed 
up your workflow (note, some >me is needed to generate the masks in your batch, but once 
done you’ll be further ahead). Then you can walk through each photo and tweak as desired. 
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Batch Export Op2ons 

For as long as I can remember people have been asking for the ability to create mul>ple 
versions of photos during export using different se<ngs for each version. Prior to this latest 
update you would have to export the first round using one configura>on of se<ngs, then 
ini>ate a second export with different se<ngs, and so on. Now, we can simply select mul>ple 
export presets to be used as part of a single export opera>on. The key is to first create the 
export presets exactly how you want them used. If you know how to do this, feel free to skip 
ahead, but for those of you who are new, read on. 

Create Export Preset 

Crea>ng an export preset is as simple as configuring the Export window with all of the se<ngs 
you want to use, then crea>ng a preset based on those se<ngs. Here’s a quick example for 
expor>ng sRGB JPGs resized to 1200 pixels on the long side. 

Step One: Select any photo, then click the Export bu^on in Library (or File > Export). You don’t 
have to actually export any copies, this is just to configure the Export dialog. 

Step Two: Set the Export To drop-down menu in the Export Loca>on panel to Choose folder 
later (useful for presets), because, well, it is useful for presets. You’ll see why in a bit. 

Step Three: Configure the File Se<ngs panel for JPG, Quality 85, and sRGB. 

Step Four: In the Image Sizing panel, check Resize to Fit, then configure Long Edge 1,200 pixels, 
and set Resolu>on to 300 (or whatever your heart desires). 

Step Five: Configure the remaining Export window’s panels to fit your needs, but the above are 
sufficient for this exercise. 
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Step Six: Click the Add bu^on (lee side) to open the New Preset dialog box, and give the preset 
a meaningful name and choose (or create) a folder for it to be created in to keep them 
organized. 

That’s it. You’ve created an export preset that can be employed all by itself any >me you need to 
export a photo with those se<ngs. In fact, you can even go to the File > Export With Preset and 
select it from that menu to ini>ate the export process without even needing to see the Export 
window appear. 

Note, with this latest update you will see a checkbox appear to the lee of each export preset 
you’ve created. If you only want to use the se<ngs in a single preset AND you want to tweak 
those se<ngs as part of the process (some>mes I use export presets as convenient star>ng 
points that I then modify as needed for the job), just click on the name of the preset (not the 
checkbox) to load those se<ngs AND keep them editable before expor>ng. 
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As soon as you check the box next to an export preset the panels of the Export window become 
read only. This is so that you can just check the boxes for any and all of the export presets you 
want to use, then click the Export bu^on to complete the process. This is why you need to 
create the export presets first. 

Batch Export 

Ok, building on the example above I also created an export preset to save a full size 8 bit TIF in 
Adobe RGB, and now I want to select a batch of photos and use both of my export presets at 
once to create a JPG and TIF version of each photo in different folders. Here’s how it works: 

Step One: Select all of the photos you want to include for export in Grid view of Library module, 
then click Export. 

Step Two: In the preset sec>on of the Export window, check the box next to each preset you 
want to use. I checked the box next to my JPG preset and the box next to my TIF preset. This 
sets the panels on the Export window to read only (and the se<ngs shown in the panels may 
not reflect the se<ngs contained in the checked presets). 
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A couple of things worth no>ng here, first, you can’t include third-party export presets in your 
batch export. For example, I have export presets for Perfectly Clear (third-party soeware) and 
while there appear to be checkboxes next to those presets, they are unclickable. Second, you 
can’t check the boxes next to presets for emailing or burning op>cal media (does anyone s>ll do 
that?). 

Step Three: Click Export. If your preset(s) included “Choose folder later” for export loca>on you 
will be presented with a dialog box for choosing (and even crea>ng) the desired folder(s). Both 
of my presets used this se<ng, so I then needed to choose the folders I wanted for this batch. 
Otherwise, I would need to create a preset for each specific loca>on I wanted copies to go. This 
provides flexibility. 
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Once the export loca>on is configured, and I clicked Done, the copies were created to my 
specifica>ons and placed in the selected folders. Very cool. I encourage you to experiment with 
how to best u>lize this added func>onality in your workflow. 

Good Resources: 

Adobe’s Lightroom Classic Community Forum: h^ps://community.adobe.com/t5/lightroom-
classic/ct-p/ct-lightroom-classic 

Adobe’s Lightroom Community Forum: h^ps://community.adobe.com/t5/lightroom-ecosystem-
cloud-based 

Lightroom Killer Tips: h^ps://lightroomkiller>ps.com/ 

KelbyOne Community (for KO subscribers): h^ps://community.kelbyone.com/  

 

I hope you’ve enjoyed this session! If you want to learn more, 
be sure to check out the latest version of my book, Lightroom 
Classic for Dummies, published in April of 2025. Reach out to 
me at robsylvan.com or the KelbyOne Community if you have 
any ques>ons. 
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